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Quick Start
Welcome to Entourage Email Archive (EEA), the simplest and quickest way
to archive your email messages.

Launch Microsoft Entourage.

Launch EEA (Entourage Email Archive). A main window appears:

Click on the top-left icon. 

The folders and subfolders of your Microsoft Entourage program will be
loaded in the popup menu in the same sequence and positions as they are
in your application. At this point select the folder that you want to archive.

Into the last textbox, “Destination folder for Archive” drag the main folder
that will be used for the final destination of your archive.
You can also click on the left icon and the standard dialog box for choosing
a folder will appear.

At this point click “Process” and EEA will start the archiving process and
show you the progress of the operation.

Preface
Entourage Email Archive can archive your email in three different ways:

Archive email and/or attachments in the Finder.

1 - Archive Emails + attachments
2 - Only Emails
3 - Only attachments

Export or append email in a text file that can be read by a text editor or
a word-processing program.

4 - Export new text file
5 - Append to text file

Export or append email in tab-text format that can be imported, for
example, in FileMaker Pro. For this export function a free template is
enclosed in the “Extra” folder in the Entourage Email Archive folder.

6 - Export new tab-text file
7 - Append to tab-text file

Settings 1,2,3 produce produce a Finder-structured-folders archive where
emails and/or attachments are grouped by day (see next pages for more
details).
Settings 4 and 5 produce a long “paper trail” file that can be viewed with a
robust text editor like BBEdit or Text-Edit Plus (SimpleText can read a
maximum file size of 32 KB)
Settings 6 and 7 produce a tab-text file that can be imported into computer
database programs, including one of the best known database programs
for the Macintosh platform, Filemaker Pro.

With the first three kinds of archives EEA can recognize if one email has
been exported. In the Log there is the line “Skipped emails (already
archived)."
When using other kinds of archives, EEA always exports all emails found.
The best solution is to delete email from Entourage after it is archived
(automatic delete of emails are in development and scheduled in the future
versions of EEA).



Using Entourage Email Archive
After you launch EEA the main window appears.
On the top you can find the Entourage icon. Click on it  to load the
structure of folders and subfolders of Entourage into the popup menu
“Source Folder”. The user can include all subfolders by clicking the
checkbox “include Subfolders”.
The checkbox “All Structure” is for archiving the complete Entourage
structure.

In the Destination box, the user can select the main folder or file
(depending on which Preferences have been chosen).

About “Include Subfolders” and “All Structure”
Depending on which of the three types of archive the user selects, the
folder and its contents may be treated differently. If the user selects the
type of archive that produces “Finder structured” folders, and if the user
selects one Entourage folder without subfolders, then the contents of this
Entourage folder will be saved directly into the output folder destination.

However, when the chosen folder contains subfolders or when
“All Structure” is selected, the complete Entourage structure (including the
main folder chosen) will be saved into the output folder destination.

Remember this for a correct output destination structure if you choose
settings 1, 2 or 3.
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Preferences
Before using Entourage Email Archive (EEA), chose Preferences from File
Menu.

The are four tabs: General, Folders, Tab Text and Filters.

Type of Archive (General Preferences)
The first three choices (Emails + attachments - Only emails - Only
Attachments) produce a “Finder Archive”, a structure of folders and
subfolders where the emails are stored by day of the year and time of the
day. For browsing this kind of archive I use and recommend to using
Sherlock (refer to page 12 for more information).

In this example the structure of folders and subfolders of Microsoft
Entourage is shown.



All emails are grouped by day. In the example, the number (089) before the
date 29 March 2000 indicates the progressive number of the day of the
year (from 1 to 365 or 366); inside this folder, you will find all emails
received that day with the “Entourage ID Message” and the email (received
or sent) time. At this level EEA saves the email + attachments.
The other two choices from the popup menu are for archiving only emails
or only attachments.

Emails are saved with the creator chosen. Attachments are saved in the
original format (Stuffit, Compact Pro, native files…).
For browsing your email archive you can use Apple Sherlock Technology
and search inside the selected folder previously indexed for search in the
contents (refer to page 12 for more information).
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When first using Entourage Email Archive I suggest creating the same
structure of folders and subfolders in the “Finder”  that are in Microsoft
Entourage. (but this structure can be created automtically if you set “All
Structure”). Later simply drag and drop the destination folder from the
Finder to the “Destination folder for Archive” textbox in EEA’s main palette.
(See page 4 for more info…)

The resulting Finder archive will be like the one in the following example:



Export new tab-text file - append to tab-text file
The command Export tab-text file is for generating a text file useful for
importing data into a database like, for example, FileMaker Pro.
A free template for FileMaker Pro 4 and 5 is included (in the folder “Extra”)
and is “open.” Users can change or modify the scripting and layout.
Before importing data into FileMaker it is important to select from the
popup menu of FileMaker Pro the command “Tab-Separated Text” as in
the following example:

The following fields are exported:
Folder: the name of the folder or sub-folder where email is located.
From: the sender of email (display name and email).
To: list of addresses (display name and email separated by commas).
Cc: list of addresses (display name and email separated by commas).
Bcc: list of addresses (display name and email separated by commas).
Date: the date of email received or sent.
Attachments: the list of attachments (separated by commas).
Subject: the subject of email.
Body: the content of email.

Export new text file - Append to text file…
When the command “Export new text file” is selected, a blank destination
file is created (click on the icon folder on main EEA window) and then filled
with the entire contents of the email messages:

When the command “Append to text file…” is chosen, EEA appends the
email messages to the end of messages in an existing file.
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Important Note:
The length of FileMaker Pro text fields are limited to 64 KB.

Append to tab-text file…
When the command “Append to tab-text file…” is chosen, EEA appends
the email messages to the end of the file.

About FileMaker Pro Template
The templates inside the folder “Extra” can be used for archiving all emails
exported with the function “Export tab-text file”.
The templates are in FileMaker Pro, versions 4 and 5.
Because FM Pro can manage dates in two different ways when the user
enters data from the keyboard (as mm-dd-yyy or dd-mm-yyyy, according
to the language and settings of your MacOs) it is necessary before using
the template to follow these steps:

You need this only the first time to initialize correctly the FM Pro document.

1. Open the template in FileMaker Pro.
2. Choose from File menu the command “Save a Copy As…”
3. Rename the file and choose from the popup menu the option “clone (no
records)”
This command changes the internal setting of the template concerning the
entry of some values like “Date”.
4. Close and open the new saved template.
5. Create a new record and type in the field “Date” the “Christmas of
December 2000” date as you usually type in Filemaker Pro (according to
the language and settings of your MacOs).
6. Press enter.
7. Because the field date is formatted to show the date as “dd Month
yyyy,” if you see 25 December 2000 (in your language), all is OK.
8. Delete this record and import the data exported from EEA (please check
the exporting settings in the “Preferences” window.
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Date format for Finder Archive (Folder Prefs)

You can set the date format for the folders (of day) created with the
following types of archives:

Emails + attachments
Only Emails
Only attachments

by choosing from the popup menu one of the following five settings:

Creator for saved files (General Preferences)
All text files saved (including Log, Log Errors and all emails) will be saved
with the creator choosen.
The list of creator choices is as follows:

Archive using (General Preferences)
From the popup menu “Archive using” choose “Received date” or “Sent
date” for archiving/exporting email. The default choice is “Received date”.

Important Note:
If you import emails from Microsoft Outlook Express into Entourage the
received dates are empty at the moment of the operation.
To confirm this “Microsoft Bug” you can include a “Received Date
column” from the View menu in Microsoft Entourage.
Because of this, if the user sets in the General Preferences “Archive
using Received Date”, EEA will find a “blank not valid date” date and
will use the “Sent date” instead of “Received Date”.
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Log
Every time Entourage Email Archive processes a folder, it writes a Log
file. The Log file is a text file showing the user the history of
tasks executed by EEA. It is possible to see the log by choosing “Show
Log” from the File menu of Entourage Email Archive.

Date format for tab-text file (Tab Text Prefs)

In the popup menu “Date format for tab-text file” choose the correct
setting for your FileMaker Pro archive. Two settings are available:

Month-Day-Year (USA format)
Day-Month-Year (Euro - Rest of the World format)

Example:
Choosing the first setting (USA) results in the email date 14 May 2000,
being written to tab-text file as 5-14-2000.
Choosing the second setting (Euro) results in the date being written as
14-5-2000.

This is important for correct import of data into FileMaker Pro archives.
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contains not all words requested. You can perform many types of queries
like:
Search all email sent from John Smith regarding Quark and ATM or
Search all email sent from John Smith in December.

You can also perform the search only on some folders of your archive:
simply drag onto the Sherlock window the folder (in my example Sent)
where you want execute the searching (you can drag and drop more than
one folder)and perform the search on every folder or volume (like disks)
you want.

Using Sherlock to browse archives
The internal Apple Search Engine called Sherlock, can perform search
functions inside the contents of files. This means that it is possible (after
indexing) to search every kind of information on archives with
Finder-structured folders created with Entourage Email Archive.

I suggest storing your archive as a Disk image created with Apple Disk
copy or on media like Jaz, Zip or on a dedicated partition on your Hard
Disk. This is because the process of indexing is related to the entire disk
and if you put your archive on your Hard Disk you need to index the entire
disk (you cannot chose to index only some folders...)

Searching for some emails (using the “find by content” feature) is very fast
on the indexed disks. Sherlock stores the invisible index file inside the disk
itself, thus when you copy the disk image file (or take your Jaz, Zip,
PocketDrive), you will copy the index automatically and you will not have to
re-index your data again.
In this way, your archive is independent and you can copy it to another
Mac and perform every kind of searching… using Apple Sherlock.
Of course, you have to update your Sherlock index every time you perform
a new “Archiving” from EEA but this is a very fast procedure (and this
operation can be scheduled at predefined intervals).

After you have exported data from your Entourage with EEA using one of
the first three kinds of archives you have created a Finder-structured-
folders archive. I think this kind of archive is best for History archives. By
History I mean that you don’t need to have thousands of Entourage emails
online, because when you want to search one specific email you can do
this using the quickest possible way: Sherlock.

Index your archive by following the instructions in the Apple Help.

After having done this, you can ask to Sherlock to find every email that
contains specific words. In my Examples I have created a query for
searching every email that contains the words Quark and ATM.
Because Sherlock performs the search using the term OR between search
words, the results are shown by relevances: long progress bars mean that
Sherlock has found all the words requested. Short bars mean that emails

11



Sherlock Examples
Query with “Kodak” and “dcs” and “tiff” on entire disk “My Archive”.

Result of query (long progress bars mean that Sherlock has found all the
words requested).

Query with “Quark” and “ATM” on folder “Sent Items” of disk “My Archive”.

Result of query (long progress bars mean that Sherlock has found all the
words requested).
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After some minutes, at the end of this task, you will see a dialog which
notifies you that all the files have been compacted successfully.
Now, you can check to see how much smaller the files “Message” and
“Database” are in the Finder.

Be sure that you have enough space on your Hard Disk, because Microsoft
Entourage used to duplicate and save the old and uncompacted files
naming them “Old Message” and “Old Database” respectively.
So, at the end of this task you should trash these old files.

Tips for Microsoft Entourage
Microsoft Entourage creates a folder for each user profile.
All of these folders are placed inside the “Office 2001 Identities:Microsoft
User Data:Main Identity” folder.
For instance, we have three users as well as three main folders: me, my
wife and my son. Inside each folder is the same structure: all emails are
stored in a single file named “Messages” and the Microsoft Database is
stored in a file called “Database”.

Creating new messages in Microsoft Entourage increases the size of these
two files. When messages are deleted, Microsoft Entourage DOES NOT
reduce the size of these two files.
To reduce this free and wasted space, you have to compact the two files
using the following procedure:
Launch Microsoft Entourage holding down the option-key just before the
splash screen appears and until you see the following dialog.
Click on the button “Rebuild”.
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Tips for Entourage Email Archive
To obtain the best performance from EEA, we suggest you disable antivirus
programs (like Virex) by switching them off from their Control Panel, and if
you opened “FileMaker Pro”, quit it (it used to make the machine too
busy). The performances are increased also if you switch off Appletalk.
You can store the “EEA Finder Archive” in a Disk Image you created before
using utilities like “Apple Disk Copy”. Launch the “Apple Disk Copy”
program and select from the “Image” menu the command “Create New
Image”. A dialog will appear. Choose a name and size for your new “Disk”.

Concerning the size you should assign to your disk: you should know that
the data extracted from Microsoft Entourage by EEA are
non-encoded, therefore the EEA data will use less space on the disk than
Microsoft Entourage did.
Click on the “Save” button and after a few seconds click on the “Erase”
button. The disk will be created and shown on your desktop.

Switch to the EEA application and choose the new disk as the destination
disk/folder.
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History Version
1.2
Entourage Email Archive (EEA) is now compatible with the new MacOs 9.1
Minor internal optimizations.
Added support for saving files with the creator type for Alpha Text Editor.
Under OS 9.1 Entourage Email Archive is about 1.25 time faster.

1.1
The Log report now provides more information about the processed
folders.
Increased the speed of the routine export tab-text (especially with long
emails.)
Fixed drag and drop on output destination box.
The PDF manual has been revised. Sherlock section is better explained with
screen shot and examples.

1.0
Initial Release.

About Registration and Pricing:
Entourage Email Archive has the following pricing:
single user license, $15 per user (US Dollars)

A Site License costs $200 and covers all locations for your organization
within a 160 kilometer (100 miles) radius of your site.

About Registration: 
Paying for the Entourage Email Archive is fairly simple.
There are two methods.
On the Web (quick, easy and secure payment on-line) and by “Register”
application (off-line).

To register on the web:
Go to the web page http://order.kagi.com/?V8B
1 - Fill the form with your name, email, address, and how many copies you
want.
2 - Click on the button “Continue” and it will appear the invoice form.
3 - Fill the fields regarding your Credit-Card datas and then click on the
button “Purchase”. That's all.
If your browser supports, you can switch on SSL secure payment form
(it's the internet international standard secure form of payment).
Your invoice will be processed in 24 hours. Therefore, you will receive by
me via Email a little text file “Registration Code” to put inside the folder
“Entourage Email Archive”

To register off-line by the “Register” application:
Launch the “Register” application, enter your name, email address and
number of single user licenses or other licenses you desire.
Save or copy or print the data from the Register program and send the
data and payment to Kagi.
Kagi handles my payment processing.
See the end of this document for more specific payment information.
The fastest way (round 3 days) is to save the invoice to a text file,
choosing “via email,” and therefore send that text file via email as
attachment to sales@kagi.com. You can also open the invoice text file with
an editor (e.g. SimpleText) selects all the text, copy and paste into the
email so as it is (without any changement). Don't forget to include your
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email address. We need to send to you the Registration Code by email.
Once your message is received by Kagi, you will receive (in round 1-2
days) by me via Email a little text file “Registration Code” to put inside the
folder “Entourage Email Archive”.

Detailed Payment Info:
If paying with Credit Card or First Virtual, you can email or fax the data to
Kagi. Their email address is sales@kagi.com and their fax number is +1
510 652-6589. You can either Copy the data from Register and paste into
the body of an email message, or you can Save the data to a file and you
can attach that file to email message. There is no need to compress the
data file; it's already pretty small. If you have a fax modem, just Print the
data to the Kagi fax number.

Payments sent via email are processed within 3 to 4 days. You will receive
an email acknowledgement when it is processed. Payments sent via fax
take up to 10 days and if you provide a correct internet email address you
will receive an email acknowledgement.

If you are paying with Cash or USD Cheque you should print the data using
the Register application and send it to the address shown on the form,
which is:

Kagi
1442-A Walnut Street #392-V8B
Berkeley, California 94709-1405
USA
You can pay with a wide variety of cash from different countries but at
present if you pay via cheque, it must be a cheque drawn in US Dollars.
Kagi cannot accept cheques in other currencies.

If you have a purchasing department, you can enter all the data into the
Register program and then select “Invoice” as your payment method.
Print three copies of the form and send it to your accounts payable people.
You might want to highlight the line that mentions that they must include a
copy of the form with their payment.
Kagi cannot invoice your company, you need to act on my behalf and
generate the invoice and handle all the paperwork on your end.

Please do not fax or email payment forms that indicate Cash, Check or
Invoice as the payment method. As far as we know, there is still no
technology to transfer physical objects via fax or email and without the
payment, the form cannot be processed.

Payments send via postal mail take time to reach Kagi and then up to 10
days for processing. Again, if you include a correct email address, you will
hear from Kagi when the form is processed.

For any information about the software of for notify me bugs or enhancement:
Stefano Cappello
Email: capste@kagi.com
Web Site: http://digilander.iol.it/capste/
For further information about the payment:
Kagi - Email: sales@kagi.com Web Site: http://www.kagi.com


